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1 Safety

P> Refer to the safety information before starting-up this gauge in order to avoid
damage to property or personal injury.

P Keep this manual in a safe place to be able to refer to any necessary descrip-
tions at a later date.

1.1 Warnings and icons used

© ATTENTION
Indicates a danger that can lead to damage or destruction of the product.

A CAUTION

Indicates a low-risk danger that could result in minor or moderate
injuries or damage to property if not avoided.

Indicates a medium-risk danger, which could result in death or
serious injuries if not avoided.

DANGER

‘

Indicates a high-risk danger, which could instantly result in death
or serious injuries if not avoided.

1 NOTE
Indicates helpful information, tips and notes

Page reference

Indicates references to further descriptions

—_
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1.2 Intended use
The gauge is intended solely for the measurement of coating thicknesses.
The measurement system (gauge and probe) is designed for operation under the fol-
lowing environmental conditions:

= Indoor and outdoor operation

= Operation outside potentially explosive areas only!

= Ambient temperature during operation: 0 ... +40 °C (+32 °F ... +104 °F)

= Operation at altitudes up to 2000 m (6561.7 ft) above sea level
Only accessories approved or recommended by the manufacturer may be connected
to the gauge.

Any further use is not in accordance with the intended use. The risk of damage re-
sulting from this is borne solely by the user!

o ATTENTION - Destruction of the gauge due to condensation
If the gauge is moved from a cold environment to a warm environment, conden-
sation can form inside the gauge and damage its electronics. Such extreme
temperature changes occur e.g. in winter between outside (0 °C (+32 °F)) and
room temperature (+22 °C (+71.6 °F)).
> Allow the gauge some time to acclimatize to the ambient temperature
before turning it on and starting a measurement.

1.3 Safety of the electrical equipment

EMC (Directive 2014/30/EU, electromagnetic compatibility)

The gauges of the DMP series comply with the regulations concerning electromag-
netic compatibility. The gauges are designed for battery operation. Mains operation
via travel charger or PC is possible, but not recommended. The guaranteed confor-
mity applies exclusively to battery operation!

‘ N
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© ATTENTION - Damage due to high temperature

When exposed to sunshine, the areas behind glass windows (e.g. in a car) can
easily reach temperatures in excess of +50 °C (+122 °F). This can cause
damage to the gauge.

Do not keep or store the gauge and accessories behind glass panes, or near to
heat sources such as radiators etc.!

0 ATTENTION - No data transfer due to damaged connection and interconnec-
tion cables

Kinking or pinching of the connecting or interconnecting cable will result in line
breakage. Excessive pulling force can cause the cable to tear out of its connec-
tion. In all these cases, data transfer (measurement signal) is no longer
possible.

> Always connect an undamaged cable to the gauge. USB: max. length 3 m
(118.17)

» Store the cable only in coiled condition, coiling radius > 20 mm (0.79 ).

P Do not use the probe and connection cable as a carrying aid!

o ATTENTION - Wrong line voltage when charging the battery
Anincorrect line voltage can lead to damage or destruction of the USB charger.

> Check the specifications for the line voltage before plugging the USB
charger into the socket. The local line voltage must match the line voltage
specified on the type plate of the USB charger.

A CAUTION - when handling the battery

Improper handling of the battery can cause the battery to overheat,
leak or burst.

» Use only batteries specified by the manufacturer to operate
this gauge:
Type RRC 1130 (3.8 V, 14.47 Wh, scope of supply)

> Prevent metal objects such as necklaces, rings, etc. from
short-circuiting the contacts.

DMP10 / DMP20 Safety
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» Do not continue to use the battery if you notice any changes
such as discoloration, deformation or damage to the outer
casing.

> Replace the battery if it is not charged after the usual charging
time. The usual charging time can be found in the technical
data.

» Do not expose the battery to excessive heat, moisture or direct
contact with water.

> Storethe gaugewithout the battery when notin use for a long
period of time.

1.4 Maintenance and repairs

Modifications, repairs, as well as maintenance and service work on the gauge and
accessories may be carried out only by service personnel authorized by the manu-
facturer.

Exception: changing the batteries/rechargeable batteries

1.5 Disposal

Do not dispose of old electronic devices and electronic accessories with house-
=S hold refuse!

> Follow the instructions in your region on the proper disposal of old elec-
tronic devices and electronic accessories!

P Dispose of damaged or defective old devices and accessories in the desig-
nated collection containers!

Do not dispose of rechargeable batteries and batteries with household refuse!

P> Follow the instructions in your region on the proper disposal of recharge-
able batteries and batteries!

P Dispose of damaged or used rechargeable batteries and batteries in the
designated collection containers!

| ~
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2 Limitation of liability

The manufacturer accepts no liability and no responsibility for the precision, conclu-
sions, and interpretation of the measurement results. Only continuous monitoring of
the measurement devices by the user can guarantee the continued precision of mea-
surements. The manufacturer accepts no liability or responsibility for consequential
damage caused by the use of incorrect measured readings.

3 Description

The gauges of the DMP series measure coating thicknesses easily, quickly, and in a
nondestructive manner. The gauge design with exchangeable probes allows a flexi-
ble use.

This Operator's Manual describes the following gauge models of the DMP series:

= DUALSCOPE® DMP20
Coating thickness measurement on ferrous as well as on non-ferrous metal
base materials (NC/FE, NF/FE, NC/NF)

= DELTASCOPE® DMP10
Coating thickness measurement on non-ferrous base materials (NC/FE,
NF/FE)

= |SOSCOPE® DMP10
Coating thickness measurement on non-ferrous base materials (NC/FE)

|§ﬂ\ Additional information can be found in the data sheet, from page 15

DMP10 / DMP20 Limitation of liability
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3.1

5
6
7
8

Scope of supply

Gauge
Li-ion battery
USB cable type C to type A, 1 m (39.4 ")

Safety information and quick guide

Gauge case

Gauge
Battery compartment lid T— —7
Light strip for displaying the mea- 24“L/‘3_8
sured reading acquisition, specifica-
tion limit violation, battery charge
status

3
Display
Operation keys,
[} on/off (press for approx. 2 s)
[=l: opens the menu when # is not
shown in the bottom line of the display 4 —
<> navigation and selection keys @ @
EA N .
| | &

o~ " 8

) 5H
~ 6
- %

The bottom line of the display always shows the function for the keys directly underneath.
The assignment depends on the open page view in the display (example).

YA

Gauge foot
Probe connection and battery fast charging plug, USB type C
USB port, type C, under the sealing tab of the battery cover

Shock protection

|§I| Gauge dimensions and further properties, see data sheet, from page 15

6

Description DMP10 / DMP20



Setting values faster
® Measure once onthe surface. You can use this value to set the desired value
faster.

® Press and hold the arrow keys % or  longer.

3.3 Overview of signals

If all signal functions in the gauge are activated, the gauge reports the following
states:
Beeps
= Short beep = measured reading acquisition complete, second beep in addition
if the specification limit is violated
Light signals
= Specification limit monitoring not active:
Green = measured reading acquisition successful
m  Specification limit monitoring active:
Red = measured reading outside the specification limits, the measured reading

itself is also displayed in red.
Green = last measured reading is within the specification limits

3.4 Softkey — icons/codes
M Forward, skips the next step in the routine
¥\ Back

® Returns to the previous menu page, displayed settings are applied
® Moves the cursor to the left, e.g. when the name is entered

S Opens the Measurement view

@- Calls up the calibration (calibration routine) from the Measurement view

DMP10 / DMP20 Description 7



112

OK

RUN

STD

STOP

TH

XN

8

Moves the cursor using the arrow keys
® Moves the selection marking

® |ncreases/decreases the numerical value displayed
Calls up the Delete function

Opens another menu page

Scrolls, displays the next page

Run
® Confirm the message/information

® Starts the function (e.g. Delete function)

Cancels the setting process and exits the function or returns to the previous
page without saving any changes

Confirm
® Confirms the selection/setting/information

® Moves the cursor to the right, e.g. when entering a name
Starts continuous count rate acquisition

Calls up the page for entering the nominal value of the calibration foil/cali-
bration standard used

Ends the continuous count rate acquisition

Switches to coating thickness display in the count rate Measurement view
(unit of measurement set as in the batch)

Switches to count rate display in the count rate Measurement view

Description DMP10 / DMP20



3.5

o O B~ W

3.6

Y

-

Measurement view

Currently measured coating/base 1 — —7
material combination, NF/FE or NC/
NF 3

Batch name 4
Specification limits 3

Reading currently being measured

Statistical values
Key assignment line (example: delete 5

function, calibration function)
6{

Status displays; icons indicate active
autom. gauge shutdown (clock), bat-

Example of the Measurement

- view showing statistics with
tery charge status or the active con- set specification limits

nection via USB for example.

Information displays; icons indicate
set measuring mode, offset, etc.

Unit of measurement

Display icons/codes
Statistics menu, contains statistical evaluations and displays for the open batch.
Batch Modify menu, contains a list of alterable batch settings
Calibrations menu, contains a list of calibrations already created, the New func-
tion for creating a new calibration and special functions for calibrations already

created, e.g. Rename, Shortened course and Delete

Gauge Settings menu, contains a list of alterable gauge settings

Indicates additional information

Indicates warnings

DMP10 / DMP20 Description 9



NF/FE

NC/NF

V'Y

® N

3

8 I ° Q

Y

x|

Displays the currently measured coating/base material combination: non-fer-
rous coating material on ferrous base material; display only with the DELTA-
SCOPE® and DUALSCOPE® gauge models

Displays the currently measured coating/base material combination: electri-
cally non-conductive and non-ferrous coating material on electrically conduc-
tive non-ferrous metals; display only with the ISOSCOPE® and DUALSCOPE®
gauge models

Battery status indicator: fully charged

Battery status indicator: replace battery soon

If the battery voltage is too low, the gauge switches off automatically, measured
readings and settings are retained

Energy-saving function, display dimming active

A period of time for at least one of the energy-saving functions is set.
USB connection active, gauge is connected to a PC via USB, for example
Free Running measuring mode active

Offset function is active

The automatic storing of measured readings is deactivated

On/0Off switch, — parameter/function is activated
On/Off switch, — parameter/function is deactivated
Parameter selection — parameter/function is activated

Parameter selection — parameter/function is deactivated

Number of measured readings

® Number of all measured readings in the batch

Arithmetic mean of the batch with n measured readings

Description DMP10 / DMP20



Min

Max

V[%]

Standard deviation for the arithmetic mean X ; a measure for the variation
of individual measured readings around their common mean value.

Lowest measured reading in the batch
Highest measured reading in the batch

The range equals the difference between the highest and lowest measured
reading in a batch

Coefficient of variation, percentage variation of a series of measurements,
standard deviation in terms of the mean value X, a sudden change in the
coefficient of variation indicates a change in process conditions

n<USL  Number of measured readings per batch below the lower specification limit

n>0GW Number of measured readings per batch above the upper specification limit

|§I| Characteristic variables occurring during the control measurement for check-

3.7

ing a selected calibration: a description of the characteristic variables can be
found on page 59

Menus - function overview

Menu Statistics

View of the statistics for the open batch

Batch Modify menu

Settings and entries for the batch

Batch Modify > MEASURE
Opens the Measurement view, starts the measurement with the probe posi-
tioned on the specimen surface

Batch Modify > Limits
Activates limit monitoring and sets the specification limits

Batch Modify > Batch Info
Information on the measurement and batch settings

DMP10 / DMP20 Description 11



Batch Modify > Views Settings

® Measurement view: selects the display

® Batch statistical display: selects the statistical characteristic variables to be
displayed

Batch Modify > Meas. unit
Sets the unit of measurement

Batch Modify > Offset
Sets the offset value

Batch Modify > More Settings > Measure Mode
Sets a measuring mode (single reading, free-running, )

Batch Modify > More Settings > Values rounding
Sets the number of decimal places for the values displayed

Batch Modify > More Settings > Save Readings
Saves measured readings (yes/no)

Batch Modify > More Settings > Air Reference
Sets the acquisition method for the air reference value

Batch Modify > More Settings > Calibration Assign
Assigns a different calibration

Menu Calibrations

Calibrations > New, starts a routine for creating a new calibration in the con-
nected probe.

Calibrations > List containing the calibrations stored in the connected probe;
After a calibration has been selected, the following functions are available:
® CALIBRATE

Starts the calibration routine for the selected calibration

® Rename
Renames the selected calibration

® Def. Cal. Check

Defines test settings for checking the selected calibration
® (Check Calibration

Starts the checking procedure for the selected calibration

® | ock Calibration
Locks the selected calibration, possible only with a pre-defined lock code

Description DMP10 / DMP20



® Shortened course
Activates a semi-automatic calibration routine

® Reset

Deletes all coating thickness correction values from the selected calibration
® [elete

Deletes the selected calibration from the probe memory

® Info
Displays information about the selected calibration

Gauge Settings menu
m  Gauge Settings > Language
Selects the display language
®m  Gauge Settings > Display Settings
Activates/deactivates display flip function and display brightness
®m  Gauge Settings > Signal Settings
® Audible signal on/off
® Activates/deactivates the visual signals and sets the luminosity

m  Gauge Settings > Energy Savings
Activates automatic gauge shutdown and display dimming after a preset period
of time

= Gauge Settings > Date & Time
Sets the date and time, and also the date and time format

= Gauge Settings > More Settings

® Define Lock Code/Delete Lock Code
Activates/deactivates the lock code for locking the calibration

m  (Gauge Settings > Probe - Menu
® Probe Raw Values
Test menu with display of probe raw data

® Set Power Line Frequency (not for gauge models ISOSCOPE®)
Adjusting the frequency of the local voltage supply to compensate for the
interference radiation emanating from the local voltage supply increases
the measuring performance for the DUALSCOPE® and DELTASCOPE® gauge
models

DMP10 / DMP20 Description 13



® elete all calibrations
Deletes all calibrations from the memory of the connected probe; NOTE: You
cannot measure without a calibration!

= Gauge Settings > About
Information about the firmware version, copyright and connected probe

3.8 Statistical characteristic variables

X — Mean Value

Arithmetic mean value (x) of all measured readings. The arithmetic mean value is
the summation of all measured readings xi of a batch, divided by the number of mea-
sured readings (n).

n — Number
Number of all measured readings in a batch.
s — Std. Dev.

Standard deviation is a measure for the variation of individual measured readings
around their common mean value (). It equals the mean square deviation of the
measured readings from the mean value.

R - Range
The range equals the difference between the highest and lowest measured reading
in a batch.

V[%] — Coeff. of Variation

Coefficient of variation, percentage variation of a series of measurements, i.e. stan-
dard deviation (s) relative to the mean value (x). The coefficient of variation is a char-
acteristic process constant. A sudden change in the coefficient of variation indicates
a change in process conditions.

Min = Low. Value
Lowest measured reading in a batch.

Max — High. Value
Highest measured reading in a batch.

<LSL-n<LSL
Number of measured readings below the lower specification limit (LSL).
>USL - n<LSL

Number of measured readings above the upper specification limit (USL).

14 Description DMP10 / DMP20



3.9 Technical Data

Description

With these gauge models you measure coating thicknesses easily, quickly, non-
destructively and with the precision that is typical for all Fischer instruments.

This gauge family contains gauges for measurement on ferrous, electrically con-
ductive base material, or both base material models.

Universally

= Universal applicable coating thickness gauges

= Various probe models are connectable to the gauges, appropriate to your indi-
vidual applications;
Measurement range, trueness and repeatability are dependent on the connect-
ed probe. You will find this data in the respective probe data sheet.

Uniform, simple and convenient operation

Calibrations for various applications are storable in and recallable from the
connected probe

Compact and robust aluminium case with protection type IP64

Battery rechargeable in the gauge or by a separate charger

DELTASCOPE  ISOSCOPE  DUALSCOPE
OMP10 OMP10 DMP20

Entry level models with small
data storage for max. 10,000
measured readings in a sin-

gle batch

o1

DMP10 / DMP20 Technical Data 1



Applications

Examples DELTASCOPE ~ ISOSCOPE  DUALSCOPE
DMP10 DMP10 DMP20

Base material steel or iron (FE)

m Zn, Cr, Cu coating on steel or iron
(NF/FE) " "

= Paint, varnish, plastic coating on
steel or iron (NC/FE)

Base material electrically conductive (NF)

= Paint, varnish, plastic coating on
Al Cu or Brass (NC/NF)

= Anodized coating on Al (NC/NF)

Metrological Features

Measurement acquisition

= Default: After each placement of the probe onto the surface, a measured read-
ing is automatically recorded

Indication of measurement acquisition

Audible by a short beep, can be disabled

Visual by colored illuminated strip (green: measured value recorded)

Limit violation: 2 short beeps, red illuminated strip and gauge vibration

Measured reading between the limits: 1 short beep, green illuminated strip and
gauge vibration

Measurement performance
Measurement speed, measurement range, trueness etc. depend on connected
probe, you will find these data in the respective probe data sheet

Storage of measured readings
Can be disabled

Measurement unit
pum, mm, mils, ginch or customized unit (definable, related to um), selectable

16 Technical Data DMP10 / DMP20



Can be disabled; limit values can be set

Can be set, is deducted automatically from the measured reading. Thus, one ob-
tains the thickness of the top coating if for instance the interim coating is known.

= Low (up to 1 decimal place)
= Medium (up to 2 decimal places)

= High (up to 3 decimal places)

= Single Reading
After each placing of the probe, the measured reading is displayed and stored
automatically in the gauge.

= Free Running
After placing the probe on the surface, the continuous display of the measured
readings appears without automatic storage, useful for quick checking of coat-
ing thicknesses over a defined surface area, e.g. in tank construction

For a correct measurement of the coating thickness, the gauge must detect the
properties (permeability, electrical conductivity, geometry) of the test piece. This
adjustment is carried out by a calibration. Furthermore, the gauge contains a
function for semi-automatic calibration.

Adjustment of the measuring system (gauge and connected probe) to geometri-
cal form and base material of the test piece (= Zero point determination) and ad-
justment to up to two coating thickness values by using calibration foils. On reca-
libration, individual calibration steps can be skipped.

The storage location for a calibration depends of the connected probe.

» Digital probe: up to 100 calibrations can be stored in the connected digital
probe;

DMP10 / DMP20 Technical Data 17



probe identifiable by the USB-C female jack and by the probe name, always be-
ginning with the letter D

Analog probe: connection via DMP-F-probe-Adapter plugged into the gauge; a
total of up to 100 calibrations can be stored in the DMP-F-Probe-Adapter; only
the calibrations that were created with the probe connected to the DMP-F-
Probe-Adapter are available in the gauge in each case.

Probe identifiable by the 10-pin male jack and by the probe name, always be-
ginning with the letter F or containing the letter F.

Checking the calibration state of the selected calibration and the measuring ac-
curacy of the measuring system. You can check whether the mean value of the
check measurement matches the reference value of the calibration standard
within the scope of measurement uncertainty (in accordance with ISO/IEC Guide
98-3).

You can lock selected calibrations.

During measurement, the air reference value is used to reference the zero point
determination. Regular measurement of the air reference value is necessary to

achieve high measurement accuracy. This is done automatically in the measure-
ment mode Single Reading when the probe is lifted off from the surface.

Default in Probe: air value acquisition as factory predefined in probe (Dynamic/
Static)

Dynamic: automatic acceptance of the air value always when the probe is lifted
from the surface, default mode

Static: no automatic acceptance of the air value always when the probe is lifted
from the surface. In this case, the air reference value must be measured man-
ually at regular intervals. This may be useful for measurements in small cavi-
ties or pipes where the minimum lift-off distance of the probe cannot be main-
tained within cavity/pipe.

18 Technical Data DMP10 / DMP20



= Simple: the measured reading with the set measurement unitis displayed only;
additionally with display of the limit values if set

m Statistics: the measured reading with tabular measurement statistics

Many different display languages, beside German and English several other Eu-
ropean and Asian languages

= settable
= Date and time formats settable (DD.MM.YY or MM/DD/YY and 12 h or 24 h)

DELTASCOPE ~ ISOSCOPE  DUALSCOPE
OMP10 OMP10 DMP20

Number of batches 1

Total number of measured readings < 10000

DELTASCOPE  ISOSCOPE  DUALSCOPE
DMP10 DMP10 OMP20

Batch statistics

Evaluation of all stored measured u u u
readings of one batch

Graphical presentation of measured
readings

Histogram of all measured readings
of one batch, from 5 readings

DMP10 / DMP20 Technical Data 19



DELTASCOPE ~ ISOSCOPE  DUALSCOPE
DMP10 DMP10 DMP20

via USB m m n
Data export via Tactile Suite to . . .
Excel® (online, offline)

Data retrieval from Tactile Suite,

batch, single readings, batch L] L] L]

statistics

DELTASCOPE  ISOSCOPE  DUALSCOPE
OMP10 OMP10 DMP20

DIN EN ISO 2178 / ASTM D7091

Magnetic induction test method,
measurement of non-magnetic coat-
ings on magnetic substrates

DIN EN ISO 2360 / ASTM D7091

Amplitude-sensitive eddy current

test method, measurement of non- = =
conductive coatings on non-magnet-

ic substrate metals

m Digital probes with USB-C female jack, probe names always beginning with the
letter D
= Via DMP-F-Probe-Adapter many analog probes with 10-pin male jack; probe
names beginning with the letter F or containing the letter F;
= Probes connectable to the DMP-F-Probe-Adapter: F20H, FA100, FA14, FA30,
FA70, FA9, FAW3.3, FD10, FD13H, FGAQ.6H FGAB1.3, FGAB1.3T, FGABW1.3,
FGB2, FGBW2, FKB10, FKB4, FTA2.4-MC, FTA2.4-SC, FTA3.3, FTA3.3-5.6,
FTA3.3-5.6-HF, FTA3.3F-Cr, FTA3.3FG, FTA3.3H, FTD3.3, V7FKB4

= Not supported probes: duplex probes (FDX10, FDX13H, FN4D) and special
probes for special customer-specific applications

The Fischer probe program encompasses nearly 100 probes designed to ensure
optimal results with highest accuracy for the widest range of measurement ap-
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plications. At factory each individual probe is adjusted at several reference points
with the greatest care to ensure the highest possible degree of trueness.

m Power supply: Li-lon rechargeable battery, model RRC1130
Nominal voltage: 3.8 V=
Nominal capacity: 3880 mA, 14.7 Wh
max. charge voltage: 4.35 V=
max. charge current: 2.4 A

= Energy saving for longest battery life
= Automatic gauge switch-off after a preset time period without operation
(key use, data transfer or measurement acquisition)

= Automatic dimming of the display brightness after a preset time period

= Battery operating period
> 24 h with continuous measurement and about +20 °C (+68 °F) ambient tem-
perature

= Battery charging time
Temperature during charging: 0 ... +45 °C (+32 ... +113 °F)
about 6 h by default
about 3 h for fast charging

IP64, dust-protected, splash-water proof

We recommend to store and transport battery and gauge separately

= Gauge with/without Li-lon rechargeable battery

= [ndoor only

= Ambient temperature: -20 ... +60 °C (-4 ... +140 °F)

= Relative humidity: 5 ... 60 %RH at 20 °C (+68 °F), non-condensing

= Ambient temperature: 0 ... +40 °C (+32 ... +104 °F)
= Relative humidity: 5 ... 85 %RH at 25 °C (+77 °F), non-condensing
= Altitude of location: up to 2000 m (6561.7 ft) (above sea level)

m Pollution degree: 3
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m Graphical display with automatic flip view (can be disabled) allows optimum
reading in different measuring positions

m Colored illumination strip to signal measurement acquisition, limit violation
and battery charging status

= 2 USB female jacks, type C

= USB 3.1, 900 mA/5 V=, at gauge bottom: for connecting digital Fischer probe
= for fast charging the Li-lon rechargeable battery in the gauge

= USB 3.1, 500 mA/b5 V=, at gauge top: for charging the Li-lon rechargeable
battery in the gauge = for connection to a PC for data transfer m max. cable
length: 3m (118 ")

Gauge with rechargeable battery: 276 g (0.61 |b)

70mm/276"
28 mm 38 mm
>
1.10" 150"
A
q ) .

50 mm
1.97

129 mm /5.08"

45

W

| —

ﬁ\—/?

Gauge, Li-lon rechargeable battery, USB cable type C to type A (1,6 m/59.06 "),
safety information and quick guide, lanyard, gauge case
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Order number

Number of batches

Storage capacity

Manufacturer’s Certificate M ac-

cording to DIN 55350-18

DELTASCOPE  ISOSCOPE  DUALSCOPE
OMP10 DMP10 OMP20

1007328 1007329 1007330
1

< 10000 measured readings

DELTASCOPE  ISOSCOPE  DUALSCOPE
OMP10 OMP10 DMP20

in conjunction with probe
only, see probe data sheet

Evaluation and archiving software

Tactile Suite

free of charge download, you
will find download link in
guide and manual on

page 67
DMP-F-Probe-Adapter for connect-
ing analog probes with 10-pin con- 1007336
nection plug
Gauge support stand 1008201
USB C cable, type Cto A, 1 m (39.4") 1008215
Charger for battery model RRC1130 1008304
Gauge foot 1005837
Battery compartment cap 1007162

You must order the probe separately. Choose the right probe for your individual ap-
plication from our comprehensive probe portfolio. Call us, we are gladly support you

with the selection.

DMP10 / DMP20

Technical Data 23



All relevant settings for measuring the coating thick-
ness of a coated specimen' and the measured read-
ings themselves are saved in the gauge in a file.
Such afile is called a batch. In order to measure, you
must assign to the batch a calibration (reference)
that is saved in the connected probe.

In the batch, you define the measurement procedure,
e.g. whether specification limits are to be monitored
during the measurement.

Example of the Measurement
view showing statistics with
set specification limits

2 steps to the measurement

1. Start-up the gauge
® |[nsert/charge the battery, Ed 25

® Connect the probe, B 29 illl statistics
® Switch on the gauge: press the [®] key for _0 Batch Modify
approx. 2 s.

) -@- Calibrations
2. Take measurements on the specimen, &1 38

@ Gauge Settings

If the specified precision is not achieved during
the measurement, you must check the calibra-
tion, 1 58. - N

Main menu

1.1n this Operator's Manual, both a coated part of any shape and size and a surface containing mul-
tiple measuring positions are referred to as a specimen.
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5 Rechargeable battery

This chapter contains important instructions on handling, changing and charging the
battery.

A CAUTION — when handling the battery

Improper handling of the battery can cause the battery to overheat,
leak or burst.

> Use only batteries specified by the manufacturer to operate
this gauge:
Type RRC 1130 (3.8 V, 14.47 Wh, scope of supply)

> Prevent metal objects such as necklaces, rings, etc. from
short-circuiting the contacts.

» Do not continue to use the battery if you notice any changes
such as discoloration, deformation or damage to the outer
casing.

P> Replace the battery if it is not charged after the usual charging
time. The usual charging time can be found in the technical
data.

» Do not expose the battery to excessive heat, moisture or direct
contact with water.

P> Storethe gaugewithout the battery when notin use for a long
period of time.

5.1 Changing the battery

Before you start

= The gauge is switched off ({®]).
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To change the battery

Make sure the
battery is the
right way round!

What you can do next

m  Charge the battery using the charger (available from Fischer as an accessory)
for battery type RRC 1130

= Continue the measurement

= Make settings for the measurement; for an overview, see page 33
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5.2 Charging the battery

o ATTENTION —-Make sure the charging power is correct

Whether you use a standard travel charger or an external charger, always make that
the battery is charged to the correct power:

Nominal voltage: 3.8 V=

Nominal capacity: 3880 mA, 14.7 Wh

max. charge voltage: 4.35 V=

max. charge current: 2.4 A

To charge the battery

= Standard - charge the battery using a commercially available charger:

P> Do this by inserting the USB-C plug of the charging cable on the top of the
gauge into the USB-C socket under the locking tab.
Battery charging time is approx. 6 h. A green light strip on the switched-off
gauge signals the end of the charging process.

USC-C plug of
charging cable

Light strip
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= Alternative 1 — quick charging using a commercially available travel charger:

P> Insert the USB-C plug of the charging cable into the USB-C socket on the
underside of the gauge (probe connection).
Battery charging time is approx. 3 h, a green light strip on the switched-off
gauge signals the end of the charging process

ISzl IS8Z2]

)
1. 2
!

Y USB-C plug of charging cable

= Alternative 2 — charge the battery using an external charger for model
RRC1130 (available from Fischer as an accessory).

a Switch off the gauge, W]

b Remove the battery from the gauge, &l 25.
c Refer to the safety Information on page 25.
d

Place the battery in the external charger.
Instructions for handling the external charger can be found in the Operator's
Manual concerned.
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6 Connecting/replacing probe

Every probe has its own identifier, consisting of a probe code (e.g. D-FN) and the se-
rial number. When a calibration is assigned to the batch, the probe identifier is auto-
matically saved in the batch. This ensures that for the batch, a measurement can be
performed only using the probe that has the same identifier as the one saved in the
batch. As a result, the correct calibration is available for the batch and for the mea-
surement.

What would you like to do?

6.1

Connect a new probe as a replacement for a defective one: proceed as de-
scribed in chapter "Replacing the probe — connecting a different probe”, Ed 31.

Connect a different probe type to the one previously used: proceed as described
in chapter "Replacing the probe — connecting a different probe”, &l 31.

Connect the probe already use for measurements in the batch: proceed as de-
scribed in chapter "Connecting the probe”, B 29.

Connecting the probe

Notes on safe secure measurement signal transfer

m Always tighten the knurled nut on the probe cable connector firmly to ensure
a secure plug connection!

= We guarantee flawless measurement signal transmission from the probe to
the gauge for a cable length of max. 3 m (118.1").

m Extending the probe cable to 3 m (118.1 ") using a USB-C extension cable is
not permitted, as the additional plug connection could impair the signal
transmission.

Before you start

The gauge is switched off ([(®]).
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To connect the probe to the gauge

= Digital probes (D...) with USB-C connecting socket, USB-C connection cable in-
cluded in the scope of supply

= Analog probes (F...) with 12-pin connecting plug via DMP-F probe adapter
(1007336, available from Fischer as an accessory)

® To attach the DMP-F probe adapter to the gauge.

1. 2. 3. 4,

S\ 1A W\ 2\\\E/f/; (LL\\\\EJ/K/JJ]
%; :‘P = PN *
d;-;b

DMP-F probe adapter
® To connect the probe to the DMP-F probe adapter.

1. 2.
SN/ N NS\ 7z D

DMP-F probe adapterw

=

Probe
connector
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6.2 Replacing the probe — connecting a different probe

You can replace a defective probe with a new probe of the same type or connect a
different probe type to the one previously used.

© ATTENTION - Data loss

If a new probe is assigned to a batch, all previous measured readings of the
batch will be lost since the measured readings previously stored in the batch
were measured using a different probe and a different calibration.

For data backup, save the batch or the previous measured readings of the
batch in Tactile Suite, Bl the link for download and further information can
be found on page 67.

Refer to the following notes whenever you want to replace a defective probe

= Youcannot transfer the calibrations from the old, defective probe to the new
replacement probe.

= With the new probe, you must perform the required calibrations and store them
in the probe. This requires the new probe to be assigned once to the batch. You
can create the calibrations you need in the calibration menu and save them in
the new probe.

m |f the probe connected to the DMP-F-Probe-Adapter is a replacement, we rec-
ommend deleting all calibrations from the old, defective probe from the DMP-
F probe adapter before assigning the new replacement probe. This prevents
the unusable calibrations from the old, defective probe unnecessarily taking up
memory space in the DMP-F-Probe-Adapter, &1, delete all calibrations from the
probe, see page 64.

Before you start

= The gauge has been switched off ([®)).

To assign the connected probe to the batch

—

. Connect the new probe to the gauge, &1 29.
. Switch on the gauge: [OD].
. Open the batch: .

~ oW

. The Reassign probe? menu page appears.
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The menu page displays the probe identifiers of the two probes: the old one
previously assigned to the batch, and the connected new probe.

5. Assign the connected probe to the batch: OK.
A message tells you that a calibration still needs to be assigned to the batch.
6. What would you like to do?

® Assign a calibration from the connected probe to the open: -@- > select
desired calibration > OK.
This completes the process and the Measurement view of the batch
appears.

® Perform a new calibration for the batch: -@- > New > follow the calibration
routine, & for the procedure, see page bé.
This completes the process and the Measurement view of the batch
appears.

Connecting/replacing probe DMP10 / DMP20



7 Settings for measurement

In order to measure, you need a batch (measuring file). Settings, such as those for
the measurement procedure are saved in the batch, e.g. specification limit monitor-
ing and measuring mode. The link to the calibration to which the measurements are
referenced is also stored in the batch file.

|§ﬂ\ m A description of the possible batch settings you have to make before a mea-
surement can be found below.

m A description of the batch settings, which you can also make after a mea-
surement, can be found from page 69.

7.1 Activating/deactivating specification limit monitoring

To activate specification limit monitoring and set the specification
limits
1. Select the specification limits to be monitored: [= > Batch Modify > OK > Limits

> OK > select desired specification limit parameter > OK.
Parameter is activated: @

The selected specification limit(s) with the currently set values appear in the
specification limit menu.

2. Set the specification limit: select specification limit > OK > set desired value >
OK.

Repeat step 2 for the second specification limit, provided you have selected
Both in step 1.

3. Exit the menu: ¥\, the settings are now made

In the Measurement view, lines with the entered specification limits appear
above and below the measured reading or a line appears below the measured
reading with the entered limit value.
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To deactivate specification limit monitoring

1. = > Batch Modify > OK > Limits > OK > Off > OK
Parameter is activated: ®

2. Exit the menu: ¥\, specification limit monitoring is deactivated.

7.2 Activating/deactivating offset function

You can correct the measured reading by a pre-defined offset value. The actual mea-
sured reading less the offset value is displayed.

Application example: coating thickness measurement on a 2-coating system with
known intermediate coating thickness that is entered as the offset value. Only the
thickness of the top coating is then displayed.

To activate the offset and set the offset value

1. = > Batch Modify > OK > Offset > OK > On > OK > set desired offset value > OK
Parameter is activated: @

2. Exit the menu: ¥\, the settings are now made.

The [0 icon appears in the Measurement view to indicate the active offset func-
tion.

To deactivate the offset function

1. = > Batch Modify > OK > Offset > OK > Off > OK
Parameter is deactivated: ®

2. Exit the menu: ¥\, the offset function is deactivated.

7.3 Selecting measuring mode

You can specify how the measured readings are to be acquired and displayed.
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Single Readings (default mode)

Measured reading acquisition after the probe is placed on the surface. The measured
readings are automatically saved in the batch (measurement file), provided the Save
Readings function is activated.

Free Running

Continuous measured reading display while the surface is being scanned with the
probe. Measured readings are not saved even if the Save Readings function is acti-
vated!

Select Free Running measuring mode if you want only an overview of the coating
thickness distribution.

To select a measuring mode

1. = > Batch Modify > OK > More Settings > OK > Measure Mode > OK > select
desired mode > OK
Parameter is activated: @

2. Exit the menu: ¥\, the settings are now made.

The Measurement view shows the C for the activated free-running measur-
ing mode.

7.4 Save measured readings on/off

You can specify whether the measured readings are automatically saved in the open
batch.

Function activated (default mode)
The measured reading is automatically saved in the open batch with every measured
reading acquisition.

Function deactivated

The measured readings are automatically saved in the open batch only temporarily.
When a different batch is called or the gauge is switched off, the measured readings
are lost.

DMP10 / DMP20 Settings for measurement 35



To activate/deactivate the save measured reading function

1. = > Batch Modify > OK > Save Readings > OK
Parameter is activated: @®

Parameter is deactivated: @

2. Exit the menu: ¥\, the setting has now been made.

The Measurement view shows the B icon to indicate that the measured read-
ing save function has been deactivated.

7.5 Air reference value — automatic/manual acquisition

The air reference value references the zero point determination for the measure-
ment.

m  Zero point determination: measurement on the uncoated base material = coat-
ing thickness 0 (normalization, zero)

= Airreference: Measurement in air = coating thickness infinite = saturation = air
reference value

To achieve a high measurement accuracy, the air reference value has to be mea-
sured on a regular basis.

You can choose between automatic (dynamic) and manual (static) acquisition of the
air reference value:

Dynamic (default mode)
Dynamic, automatic acquisition of the air value each time the probe is lifted off the
surface.

Static

Static, no automatic acquisition of the air value each time the probe is lifted off the
surface. The air reference value has to be measured manually at regular intervals.
Useful for measurements in small cavities or pipes where the minimum Lift off
distance of the probe cannot be maintained within the cavity/pipe.

Default in Probe
Information about the acquisition method for the air reference value set in the probe
in the factory.
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To change the acquisition method for the air reference value

1. =l > Batch Modify > OK > More Settings > OK > Air Reference > OK > set service
code (159) > OK > set desired acquisition method > OK
Parameter is activated: @

2. Exit the menu: ¥\, the setting has now been made.

7.6 Assigning a different calibration to the opened batch

To assign a different calibration to the batch

> = > Batch Modify > OK > More Settings > OK > Calibration Assign > OK > select
the desired calibration from the list > OK

A different calibration has now been assigned.
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8 Measure

8.1

Notes on measuring

The information for precision (remaining deviations from precision to mea-
sured reading) and repeatability (repeated standard deviation) applies for the
ambient and reference piece temperatures at the time of the calibration. The
values for precision and repeatability may be higher than the values indicated
in the data sheet if the temperatures during the measurement deviate from the
ambient and reference piece temperatures during the calibration.

As a basic rule: If the specified precision is not achieved during the measure-
ment, you must check the calibration recalibrate the probe if necessary.

If all signal functions in the gauge are activated, the gauge reports the following
states:

Beeps

® Short beep = measured reading acquisition complete, second beep in addi-
tion if the specification limit is violated

Light signals

® Specification limit monitoring not active:
Green = measured reading acquisition successful

® Specification limit monitoring active:
Red = measured reading outside the specification limits, the measured
reading itself is also displayed in red.

For the following measurement situation, we recommend setting the acquisi-
tion of the air reference value to Static:

® Measurements in cavities and pipes if the minimum lift off distance of
4 x the probe measurement range cannot be respected, Bl 43
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8.2

Handling the probe

In addition to the calibration, the way in which the probe is placed on the surface is
also crucial for a precise measurement. Measured reading acquisition via the probe.

8.3

Important notes for correctly handling the probe during the measurement

= Always hold the probe at its grip sleeve.

m Always place the probe perpendicular and gently on the surface.

m For the measurement, place the probe quickly on the surface, do not allow
the probe to hover over the specimen.

m In default mode, a beep and a green light strip signals that the measured
reading has been acquired. Only then lift the probe off the surface, lift off
distance > 4 x the probe measurement range.

= Two-tip probe: For specimens whose base materials have a magnetic
preferred direction, we recommend determining the measured reading by
taking the average of two measurements, whereby the probe is to be rotated
by ?0° after the first measurement. Not relevant for the ISOSCOPE® gauge
models.

Before you start

The measuring area and the probe tip on the probe are clean, free of oil, dust,
etc.

The probe is connected to the gauge.

The gauge is acclimatized and the battery are sufficiently charged for the up-
coming measurement.

In the event of an online data transfer during the measurement, connections
suitable for Tactile Suite are configured.

During the measurement, you can also perform the following actions
in the Measurement view

Delete single/all measured readings: press the [ key.
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8.4 Measuring in single reading measuring mode - procedure

Measuring on flat specimens - single-tip probe

The display screens should be considered only as examples, the gauge default modes are required here
for the measured reading acquisition, probe D-FN is shown as a typical example of our axial probes

1. Position the gauge 2. Measured reading ac- 3 Lift off the probe
quisition g

> 4 x probe
measurement
- A
/Coated specimen 2 range
iz

Measuring on cylindrical specimens - single-tip probe

The display screens should be considered only as examples, the gauge default modes are required here
for the measured reading acquisition, probe D-FN is shown as a typical example of our axial probes

1. Position the gauge 2 Measured reading ac- 3 Lift off the probe
QUISTTION e

> 4 x probe
measurement

!

m range

Coated
specimen
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Measuring on flat specimens - two-tip probe

The display screens should be considered only as examples, the gauge default modes are required here for
the measured reading acquisition, probe D-F90-2t8 is shown as a typical example of a 2-tip probe

1. Position the gauge 2 Measured reading ac- 3 Lift off the probe
QUISITION o

> 4 x probe

measurement
Z%W% range

Additional measurement with 90° rotated probe when measuring on specimens with
magnetic preferred direction.

Coated specimen
/////////////////////

ll-. Rotate probe 5 Position the 6 Acquire the 7 Lift off probe
through 90° probe measured
readlng

v,

7,
/9%*99/59999199/,// W% 77

Measuring on cylindrical specimens - two-tip probe

The display screens should be considered only as examples, the gauge default modes are required here for
the measured reading acquisition, probe D-F90-2t8 is shown as a typical example of a 2-tip probe

1. Position the gauge 2. Measured reading ac- 3 Lift off the probe

X = 4 x probe mea-
surement range

Coated
specimen
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8.5 Measuring in free-running measuring mode - procedure

No measured readings are saved!

Measuring on flat specimens
The display screens should be considered only as examples, the gauge default modes are required here for
the measured reading acquisition, probe D-FN is shown as a typical example of any probe

1. Position the gauge 2 Measured reading 3 Lift off the probe
display
1

1

> 4 x probe
measurement
range

~Coated specimen z
iz

0707,

Measuring on cylindrical specimens - single-tip probe

The display screens should be considered only as examples, the gauge default modes are required here for
the measured reading acquisition, probe D-FN is shown as a typical example of our axial probes

1. Position the gauge 2. Measured reading 3. Lift off the probe

> 4 x probe
measurement
range

Coated
specimen

Measuring on cylindrical specimens - two-tip probe

The display screens should be considered only as examples, the gauge default modes are required here for
the measured reading acquisition, probe D-F90-2t8 is shown as a typical example of a 2-tip probe

1. Position the gauge 2. Measured reading 3. Lift off the probe
acquisition

- — Q‘% S : :

o L ) NS o = R

Coated { ] x = 4 x probe mea-
specimen surement range
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8.6 Measuring with manual recording of the air reference value

If the minimum lift off distance of 4 x the probe measurement range cannot be main-
tained when measuring in cavities and pipes, you can also record the air reference
value manually at regular intervals.

Before you start

= Air value recording is set to Static, Bl 36

= Refer to the notes on measurement at the beginning of this chapter

To measure with manual recording of the air reference value

1. Perform your measurements as described in the previous chapters.
We recommend recording the air reference value at regular intervals, e.g.
between each specimen or after every 10th specimen.

2. Record the air reference value: @- > hold the probe in the air > OK > ¥X.
The manual recording of the air reference value is now complete.

3. Repeat steps 1. and 2. for subsequent measurements.
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9 Calibration

The term “calibration” is used in this Operator's Manual as a general term for deter-
mining the deviation from a reference value, adjustment and correction: calibration
of the gauge using calibration standards to adapt the measuring system (gauge and
probe) to the measuring application at hand.

The calibration sets the difference between nominal and actual value to zero.

A calibration is a reference measurement during which the material properties and
geometric shape of the specimen are recorded and stored in a calibration file in the
connected probe, separate from the batch. During the reference measurement, the
influencing variables are recorded using an uncoated reference piece and one or two
calibration standards in order to compensate the influences for future measure-
ments.

m  Uncoated reference piece, the material of which has the same properties as the
base material of the specimen. Needed for adjustment to the base material (ze-
ro = zero point).

= Calibration standard, available in different versions:

® C(Calibration foil, plastic foil, hard paper foil or metal foil with a certain thick-
ness, characterized by the nominal value that simulates a coating thickness
during the calibration process. An adjustment to the corresponding coating
thickness value is performed for each calibration foil thickness.

® C(Calibration standard, coated reference piece whose base material and
coating material have the same properties as the coated specimen and
whose coating thickness has been determined using the most accurate
alternative measurement method possible (nominal value of the calibration
standard).

In order to measure, it is absolutely essential that a calibration suitable for the mea-
suring application has been assigned to the batch.

The coating thickness measurement is mainly influenced by the following variables:

m  Physical properties of the base material of the specimen, such as magnetizabil-
ity (permeability) or electrical conductivity

= Geometric shape of the specimen, such as the thickness of the base material
or the curvature of the specimen (e.g. cylindrical shape)
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= Position of the measuring position on the specimen, such as distance from the
edge, hole, platform, or step

= Surface roughness

9.1 Overview of calibration methods

Zero (zero point, calibration step Zero)

This is the simplest type of calibration and is used to calibrate the gauge to a refer-
ence point, the base material, which is called zero here (zero point). The measure-
ment is taken on a reference piece that has the same material and shape as the ac-
tual uncoated specimen to be tested. It consists only of the specimen base material
(magnetizable (FE) or non-magnetizable (NF), depending on the test method used).

Zero + 1 standard (calibration steps Zero and Std. 1)

A calibration using a calibration standard achieves the best measurement accuracy
in a narrow measurement range around the stated standard thickness. The calibra-
tion method Zero + 1 standard can be used only in the lower measurement range of
the gauge.

You can find the values available for the calibration standard in the probe data sheet.

Zero + 2 standards (calibration steps Zero, Std. 1 and Std. 2)

On the one hand, a calibration with 2 calibration standards achieves the best mea-
surement accuracy in the measurement range that is limited by the two calibration
standard values; on the other hand, however, 2 calibration standards are needed to
calibrate the upper measurement range of the gauge.

For a calibration with 2 foils, you can find the foil pairings in the probe data sheet.
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9.2

Please observe the following information on calibration/
recalibration

The reference piece and specimen must have the same base material proper-
ties.

The positions of the measuring position on the reference piece and on the spec-
imen to be measured must be roughly the same (curvature, distance from the
edge, hole, platform, and step).

The information for precision (remaining deviations from precision to mea-
sured reading) and repeatability (repeated standard deviation) applies for the
ambient and reference piece temperatures at the time of the calibration. The
values for precision and repeatability may be higher than the values indicated
in the data sheet if the temperatures during the measurement deviate from the
ambient and reference piece temperatures during the calibration.

If measurements are to be performed on both magnetizable (FE) and non-mag-
netizable (NF) base materials, the calibration must be performed using both
base materials (FE and NF)! This is useful when using a dual probe, such as
FD13H and D-FN.

Treat the calibration standards = calibration foils with care. Replace soiled,
bent, scratched or cracked calibration foils or those with severe indentations.
In particular foils with thicknesses of less than 50 um (2 mils) are subject to
rapid wear. Recommendation: replace the calibration foils after no more than
100 to 200 measurements!

Perform the calibration with care! This is the benchmark for the accuracy to
which the following measurements can be performed. — Measurements can
never be more accurate than the calibration itself!

Do not use the metal sheet (NF/FE or ISO/NF) supplied with the gauge as a ref-
erence piece! As a rule, the material properties of the metal plate will not cor-
respond to those of your own uncoated specimen/reference piece! The metal
plate(s) serve only to check the function of the gauge!

Calibration on NF base material (NF = non ferromagnetic base material): the
difference between the reference piece temperature during the calibration and
the specimen temperature during the measurement should be minimal. Exces-
sive temperature differences have an adverse effect on the measurement ac-
curacy.
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9.3 Calibration — when is it necessary?

New calibration — when is it necessary?

= When there is a new specimen, the properties for which no calibration has yet
been created. In this case, you have to record the influencing variables with a
new calibration in order to compensate for them when measuring.

= For measurements on magnetizable base material (FE), it makes sense to per-
form a calibration with at least 1 calibration standard.

= If the specimen has a very low (e.g. titanium, stainless steel) or very high (e.g.
copper, silver) electrical conductivity when measured on non-magnetizable
base material (NF), we recommend performing a calibration with at least 1 cal-
ibration standard here as well.

Recalibration — when is it necessary?

= The measurement does not achieve with the specified degree of precision.

= The check of the current calibration delivers a negative result.

9.4 Recalibration

A recalibration is in effect the repeat of an existing calibration. The calibration data
are overwritten when a calibration routine is run again.

During the recalibration, you can skip individual calibration steps (Zero or Std. 1/2).

In the case of rough surfaces, it may be advisable to skip the Zero calibration
step during the recalibration. Repeat measurements on the rough base mate-
rial do not usually deliver better values. However, if the permeability of the
specimen base material has changed, you must perform the Zero step on the
base material with the changed permeability!

DMP10 / DMP20 Calibration 47



Before you start

Refer to the notes on calibration, &1 46

The probe in which the calibration to be recalibrated is stored is connected to
the gauge.

Reference piece and/or calibration foils are ready. You can find the parts you
need on the calibration info page: = > Calibrations > OK > select name of cali-
bration > OK > Info.

If the calibration you want to repeat is locked, you need to know the lock code.

To repeat an existing calibration

1.

Open the calibration to be repeated:

® (Qpen a calibration from the list: (= > Calibrations > OK > select name of cali-
bration > OK > CALIBRATE.

® (Open the calibration used in the batch: -@ (in the Measurement view).

. Prompted to set the lock code?

® Yes: Set the lock code and deactivate the lock function, & 63
function is deactivated: @

® No: Continue with step 3.

. Follow the routine and perform the calibration steps (Zero, Std. 1/2).

a "Calibration step Zero — Procedure”, @ 49
b "Calibration step Std — procedure”, B 51

Notes

= |f the Shortened course function is activated, the calibration routine switches
automatically to the next calibration step after every 3 measurements. It is
not possible to correct/change the specified calibration foil when this func-
tion is activated.

m |f you have deactivated the lock function for recalibration, do not forget to
reactivate the lock function before exiting the calibration menu, & 62.
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9.4.1 Calibration step Zero — Procedure

Measure on the uncoated reference piece.

Required material

= Base material FE: ferromagnetic material = FE = ferrous reference piece from
customer’s own production, without the coating to be measured; NF/FE dis-
play screen

= Base material NF: non-ferromagnetic, electrically conductive material = NF =
non-ferrous, electrically conductive reference piece from customer's own pro-
duction, without the coating to be measured; NC/NF display screen

To perform the zero calibration step Zero
1. Perform 5 to 10 measurements on the uncoated reference piece.

A Position the gauge B Measured reading C Lift off the probe
acquisition

1

Uncoated
reference piece

> 4 x probe
measurement
range

The display screens should be considered only as examples, the gauge default modes are required here
for the measured reading acquisition.

Repeat Steps A to C for the subsequent measurements on the uncoated refer-
ence piece.

2. Finish the calibration step Zero: OK.
What would you like to do?

P> Finish the calibration: 1 x £
The measuring system is now calibrated to the base material and the part
geometry (= Zero = zero point), the calibration is finished, the calibration menu
with the calibration list appears in the display

w

> Continue the calibration with calibration standard(s): continue with "Calibration
step Std — procedure”, B 51

DMP10 / DMP20 Calibration 49



Display description — Zero calibration step

10
1

Base material currently being measured 1 NF/FE )
(example FE) 2 Calibration 003

Name of calibration (example)

Schematic illustration of the current cali-
bration step

Current calibration step

Progress display of the calibration steps
(example: calibration step 1 current = cal-
ibration step Zero)

Current measured reading (example)

Mean value of the measured readings re-
corded up to now in the current calibration step (example)

Deletes the last measured reading
Battery status display
Number of measurements in the current calibration step (example)

Continue to next calibration step / exit calibration

Calibration DMP10 / DMP20



9.4.2 Calibration step Std — procedure

Measure on the calibration foil that is directly on top of the uncoated reference piece.

Required material

= Base material, reference piece from customer's own production, without the
coating to be measured already used during the Zero calibration step.

m  Calibration foils with the desired thicknesses or from the scope of supply for
the connected probe, the circle on the foil marks the specified measuring area

To perform the zero calibration step Std

1. Place the calibration foil (1/2) (= Std. 1/2) on the uncoated reference piece.

— = Calibration foil (= Std)

Uncoated
reference piece

o Only one foil at a time may be on top of the uncoated reference piece!

Specified measuring
position

2. Perform 5 to 10 measurements on the calibration foil (Std. 1).

A Position the gauge B Measured reading C Lift off the probe
acquisition

Ee o

Specified mea-
suring position

Calibration foil > 4 x probe

measurement
range

The display screens should be considered only as examples, the gauge default modes are required here
for the measured reading acquisition.

Uncoated

reference piece

Repeat Steps A to C for the subsequent measurements on the uncoated refer-
ence piece.

3. Enter the nominal value of the Std. 1: STD > set nominal value> OK.
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o

Finish the calibration step Std 1: OK.
What would you like to do?

Finish the calibration: 1 x 7

The measuring system is now calibrated to the base material (Zero) and the
part geometry as well as to a reference value (Std 1), the calibration is finished,
the calibration menu with the calibration list appears in the display

Continue the calibration with the 2nd calibration standard: OK > repeat steps 1.
to 4. with the second calibration foil (Std 2)

The measuring system is now calibrated to the base material (Zero) and the
part geometry as well as to two reference values (Std 1 and Std 2), the calibra-
tion is finished, the calibration menu with the calibration list appears in the
display.

Display description — Std calibration step

10
11
12

Base material currently being measured 1 NF/FE© == —9
(example FE) 2 Calibration 003

Name of calibration (example)

Schematic illustration of the current cali-
bration step

Current calibration step

Progress display of the calibration steps
(example: calibration step 2 current = cal-
ibration step Std 1)

Current measured reading (example)

Mean value of the measured readings re-
corded up to now in the current calibra-
tion step (example)

Deletes the last measured reading

Battery status display

Number of measurements in the current calibration step (example)
Continue to next calibration step / exit calibration

Opens the page for entering the nominal value of the foil
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9.5 Calling up information about the calibration

You can call up information for a selected calibration.

Before you start
= The probe containing the calibration whose information you want to view is
connected to the gauge.

= |f the calibration whose information you want to call up is locked, you need to
know the lock code.

To call up information about a calibration

1. Select the calibration whose information you want to call up: = > Calibrations >
OK > select name of the calibration > OK.

2. Prompted to set the lock code?

® Yes: Set the lock code: :

® No: Continue with step 3.
3. Open the information page: Info > OK.
4. Exit the information page: ¥\,

Description of parameters on page Info

Only the standards, with their values, that were used for the calibration are displayed
on the information page next to the date and time.

Std 1 (NF/FE): 100 um (example)
Calibration on ferrous base material (FE), indication of the foil thickness (nominal
value) for the Std. 1, used for this calibration.

Std 2 (NF/FE): 527 um (example)
Calibration on ferrous base material (FE), indication of the foil thickness (nominal
value) for foil 2 used for this calibration.

Std 1 (NC/NF): 89.9 um (example)
Calibration on non-magnetizable base material (NF), indication of the foil thickness
(nominal value) for foil 1 used for this calibration.
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Std 2 (NC/NF): 201 ym (example)
Calibration on non-magnetizable base material (NF), indication of the foil thickness
(nominal value) for foil 2 used for this calibration.

Date / Time:
13.04.2022 10:23 (example): storage time of calibration

9.6 Activating/deactivating semi-automatic calibration routine

The Shortened course function activates a semi-automatic calibration routine for the
selected calibration. If the Shortened course function is activated, the calibration rou-
tine switches automatically to the next calibration step after every 3 measurements.
The next calibration step is signaled only through the display of the required stan-
dard value. It is not possible to correct/change the specified calibration standard
when this function is activated.

Before you start
= The probe is connected to the gauge containing the calibration for which you
want to activate/deactivate the semi-automatic calibration routine.

= [f the calibration for which you want to activate or deactivate this function is
locked, you need to know the lock code.

To activate/deactivate the function for a calibration
1. Select the calibration for which you want to activate/deactivate the function: =
> Calibrations > OK > select name of calibration > OK.
2. Prompted to set the lock code?

® Yes: Set the lock code and deactivate the lock function, & 63
function is deactivated: @

® No: Continue with step 3.
3. Activate/deactivate the function: Shortened course > OK.

Function is activated: @®
At the next recalibration, the calibration routine will be performed semi-auto-
matically.

Function is deactivated: @
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4. Did you deactivate the lock function in step 2.7

® Yes: Reactivate the lock function, & 62
function is activated: @®

® No: Continue with step 5.

5. Exit the menu: ¥\, the function is now activated/deactivated.

9.7 Calibration - reset

You can reset a calibration and delete all the correction values (coating thickness) of
the selected calibration. The function deletes all parameters measured in the Std
calibration steps. The entered standard nominal values and the measurements of
the Zero calibration step are retained.

Before you start

= The probe is connected to the gauge containing the calibration you want to re-
set.

= |f the calibration for which you want to activate or deactivate this function is
locked, you need to know the lock code.

To reset the selected calibration
1. Select the calibration you want to reset: = > Calibrations > OK > select name of
calibration > OK.
2. Prompted to set the lock code?

® Yes: Set the lock code and deactivate the lock function, B2 63.
Function is activated: @®®

® No: Continue with step 3.
3. Start the function: Reset > OK.
4. Confirm the prompt asking whether you want to proceed with the Reset: v
5. Did you deactivate the lock function in step 2.7

® Yes: Reactivate the lock function, B 62
function is activated: @®

® No: Continue with step 6.

6. Exit the menu: ¥\, the calibration has now been reset.

DMP10 / DMP20 Calibration 55



9.8 Creating new calibration
In the following cases, you have to record the influencing variables with a new cali-
bration in order to compensate for them when measuring.

m  When there is a new specimen, the material properties, geometry and coating
thickness range for which no calibration has yet been created.

= You have determined during test measurements that none of the listed calibra-
tions is suitable for the specimen at hand.

Before you start

= Refer to the notes on calibration, Ed 46.
= The probe with which the new calibration is to be performed is connected to the
gauge.

m  Reference piece and/or calibration standards (calibration foils) are ready.
The parts you need depends on the specifications in the directives/standards
or the measurement accuracy required.

[ Overview of calibration methods, page 45

To create a new calibration

1. Open the calibration menu New: =l > Calibrations > OK > New > OK.

2. Follow the routine and perform the desired calibration steps (Zero, Std. 1/2).
a "Calibration step Zero — Procedure’, @ 49
b "Calibration step Std — procedure”, @ 51

This completes the creation process for a new calibration. The calibration is stored
in the connected probe or in the DMP-F probe adapter under the probe identifier of
the connected probe.

Keep in mind that many calibrations involving different calibration methods for
different base materials can be stored in the probe/DMP-F probe adapter. A
unique name makes it easier to select and assign the desired calibration to a
batch.

[ Calibration - assigning/changing names, page 57
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9.9 Calibration - assigning/changing names

Assign a unique name to the calibration (calibration method, material designation,
batch no., ...), example: Z+1F EN AW 6082 or Z EN AW 6082.

Keep in mind that many calibrations involving different calibration methods for
different base materials can be stored in the probe/DMP-F probe adapter. A
unigue name makes it easier to select and assign the desired calibration to a
batch.

Before you start
= The probe is connected to the gauge (via DMP-F probe adapter) containing the
calibration whose name you want to change.

= [f the calibration whose name you want to change is locked, you need to know
the lock code.

To change the name of a calibration
1. Select the calibration whose name you want to change: [= > Calibrations > OK >
select name of calibration > OK.
2. Prompted to set the lock code?

® Yes: Set the lock code and deactivate the lock function, &3 63.
Function is deactivated: @

® No: Continue with step 3.
3. Open the input menu: Rename > OK.
4. Change the name:
® Move cursor using the ¥\ and OK keys
® Select characters using the $ and OK keys
® Delete characters by selecting the space (i)
5. Exit the input menu:

a Move the cursor to the far right using the OK key. The character <;£] appears
at the right edge of the display.

b Press OK to close the input menu.
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6. Did you deactivate the lock function in step 2.7

® Yes: Reactivate the lock function: B 62.
Function is activated: @®

® No: Continue with step 7.

7. Exit the calibration menu: ¥\, the name has now been changed.

9.10 Checking the precision of a calibration

The Check Calibration function checks during a control measurement whether the
mean value of the control measurement matches the nominal value of the used foil
within the measurement uncertainty (in accordance with ISO/IEC Guide 98-3).

Important to know

m  The Check Calibration function allows you to check the calibration state of the
selected calibration and the measurement accuracy of the measurement sys-
tem. The result of the check applies only to the calibration selected.

= The check must be performed under the same conditions applied for the cali-
bration procedure, at the same temperature, using the same base material for
example.

= The precision of the calibration is limited by the measurement uncertainty of
the calibration standard (calibration foil). The measurement uncertainty of the
calibration must not be smaller than the measurement uncertainty of the cali-
bration standard used. To improve the calibration precision, you must use cal-
ibration standards with smaller measurement uncertainties for the calibration
procedure.

m  Thedetermined measurement uncertainty applies only to a small range around
the nominal value of the foil for which the control measurement was per-
formed.

If you wish to determine the measurement uncertainty for a measurement
range, perform control measurements on two foils that limit the measurement
range. You can determine the measurement uncertainty for this measurement
range through a linear interpolation of the two measurement uncertainties of
the control measurements on the two foils.
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Before you start

The test parameters for the selected calibration are defined.
Defining the test settings, Bl 61.

The probe is connected to the gauge containing the calibration you want to
check.

Reference piece and a calibration standard (calibration foil) already used for
the calibration procedure are ready. You can find the parts you need on the cal-
ibration info page: = > Calibrations > OK > select name of calibration > OK > Info.

Before the control measurement is carried out, the gauge with connected probe
must have been switched on for at least 10 minutes! This is necessary to en-
sure that all gauge components have reached their operating temperature.
Otherwise, slightly increased measurement errors can occur!

If the calibration you want to check is locked, you need to know the lock code.

To check the desired calibration

1.

Select the calibration whose measurement accuracy you want to check: = >
Calibrations > OK > select name of calibration > OK.

. Prompted to set the lock code?

® Yes: Set the lock code and deactivate the lock function, &3 63.
Function is deactivated: @

® No: Continue with step 3.
Start the function: Check Calibration > OK.
Place the foil for the control measurement on the base material.

Take a few control measurements on the foil. We recommend taking 10
measurements. The circle on the foil marks the specified measurement area.

Description of the displayed variables on the Check Calibration page:

® V3l: Nominal value of the calibration standard (calibration foil), set in the
Def. Cal. Check menu.

® Aabs: Tolerance/uncertainty of the foil, set in the Def. Cal. Check menu.
® Nmin: Minimum number of required measurements

® X: Arithmetic mean value, determined from the measurements taken; red
values are outside the tolerance limits
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6.
7.

® s: Standard deviation, determined from the measurements taken; red
values are outside the tolerance limits

® n: Number of measurements taken

Start the check: OK
An information page displays the following result:
Calibration is OK

The mean value of the control measurement matches the nominal value

(= reference value) of the used calibration standard (calibration foil) within the
measurement uncertainty (in accordance with ISO/IEC Guide 98-3). This means
that the difference between the mean value and the nominal value cannot be
distinguished from the specified measurement uncertainty of the calibration
standard. The measurement accuracy for the open batch is OK for the calibra-
tion standard used and cannot be further improved by this calibration standard.

Calibration is NOT OK

The measured mean value of the control measurement has an excessive devi-
ation from the nominal value of the calibration standard (calibration foil). First,
perform a recalibration. Be sure to use standard values appropriate for the
selected calibration method.

|§-| = The data sheet of the probe provides the values available and suitable
for the calibration standard(s).
m Also refer to the note on "Precision” on page 58.

8. Finish the check: OK

10.

. Did you deactivate the lock function in step 2.7

® Yes: Reactivate the lock function, B 62.
Function is activated: @®

® No: Continue with step 10.

Exit the calibration menu: ¥\, the calibration check has finished.

Tips

= |f the calibration check fails even after recalibration, perform a new recali-
bration only with calibration step Zero, skipping the other calibration steps via
N

m Reset the calibration using the Reset function, &1 55
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9.1 Defining the test criteria for the calibration check

You can perform a control measurement to check the precision of a selected calibra-
tion. The check is based on the measurement uncertainty (tolerance) specified for
the calibration standard (calibration foil) used during the control measurement. To
be able to check a calibration, you have to enter for this calibration the measurement
uncertainty or tolerance for the calibration standard you want to use for the check
(control measurement).

Before you start

= You know the tolerance or the measurement uncertainty (k=2) for the calibra-
tion standard to be used later during the control measurement. These values
can be noted in a certificate or on the calibration standard itself.

= The probe is connected to the gauge containing the calibration whose test cri-
teria you want to define.

= Please also refer to section "Important to know", @ 58.

= |f the calibration whose test parameters you want to enter for the check is
locked, you need to know the lock code.

To define the test criteria
1. Select the calibration for which you want to enter the test criteria: [=] > Calibra-
tions > OK > select name of calibration > OK.
2. Prompted to set the lock code?

® Yes: Set the lock code and deactivate the lock function, B2 63.
Function is deactivated: @

® No: Continue with step 3.
3. Open the settings menu: Define Cal. Check > OK.

4. Select the format in which you have the uncertainty/tolerance values for the
calibration standard you intend to use for the check (control measurement)
later: select desired tolerance value > OK.

Parameter is activated: @

Parameter selection:
® No: Check function deactivated

® Abs. Tol, example: £ 1.5 um
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® Rel Tol, percentage value, example: + 1.25 %

® Uncertainty, example: expanded measurement uncertainty for an expansion
factor k=2: + 4.5 um

5. Set the nominal value and the tolerance/measurement uncertainty for the cali-
bration standard you intend to use for the check (control measurement) later:
Reference Value > OK > set value > OK.

Repeat Step 5. for the tolerance/uncertainty.

When entering, pay attention to the unit of measurement. Enter the values
in the unit of measurement set for the batch.

Input parameters:
® Reference Value: Nominal value of the calibration standard

® Abs. Tol./Rel. Tol. or U(k=2): Tolerance/measurement uncertainty value of
the calibration standard

6. Did you deactivate the lock function in step 2.7

® Yes: Reactivate the lock function, @ 62.
Function is activated: @®

® No: Continue with step 7.

7. Exit the menu: ¥\, the test criteria are now defined.

9.12 Lock calibration

The Lock Calibration function locks the opening and the calibration routine of the se-
lected calibration. You can unlock the menu for the locked calibration and calibration
routine only by entering the lock code. This lock function can be used only if a lock
code is defined in the gauge.

Before you start

= The probe is connected to the gauge containing the calibration you want to lock.

= A lock code is defined in the gauge, B 77

To lock a calibration

1. Select the calibration you want to lock: =] > Calibrations > OK > select name of
calibration > OK.
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2. Activate the lock function: Lock Calibration > OK.
Function is activated: @®
3. Exit the menu: ¥\, the locking process has finished.

To access the menu and the calibration routine of the locked calibration, you
now need to enter the lock code.

9.13 Calibration — deactivating lock

The Lock Calibration function blocks access to the menu and to the calibration routine
of the selected calibration. You can deactivate the lock function for the menu and the
calibration routine of the locked calibration only by entering the lock code.

Before you start
= The probe is connected to the gauge containing the calibration whose lock you
want to deactivate.

= To deactivate the lock function of a calibration, you need to know the lock code.

To deactivate the lock of selected calibration
1. Select the calibration whose lock you want to deactivate: [= > Calibrations > OK
> select name of calibration > OK.
2. Deactivate the lock:
a Set the lock code: set lock code > OK.

b Deactivate the lock function: Lock Calibration > OK.
Function is deactivated: @

The unlocking process is finished, you now have free access to the functions in the
menu of the selected calibration.

Before exiting the calibration, do not forget to reactivate the lock function for
the menu of the selected calibration, &l 62.
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9.14 Deleting a calibration

You can delete individual calibrations from the memory of the probe/DMP-F probe
adapter.

Before you start
= The probe is connected to the gauge containing the memory from which you
want to delete a calibration.

= |f the calibration you want to delete is locked, you need to know the lock code.

To delete a calibration
1. Select the calibration you want to delete: [=] > Calibrations > OK > select name
of calibration > OK.

2. Prompted to set the lock code?

® Yes: Set the lock code and deactivate the lock function, B3 63.
Function is deactivated: @

® No: Continue with step 3.
3. Select the delete function: Delete > OK.
4. Start the delete process: v

5. Exit the menu: ¥\, the delete process has finished.

9.15 Deleting all calibrations

You can delete all your calibrations from the memory of the connected probe. This
function deletes all the calibration files and all their datal!

DMP-F probe adapter: You can use this function to delete all calibrations from the
DMP-F probe adapter that were created using the connected probe. Useful when an
existing probe is to be replaced by a new one. In this case, the calibrations of the old
(e.g. defective) probe are no longer needed, so they can be deleted and do not unnec-
essarily take up memory space in the DMP-F probe adapter.

© ATTENTION
m Please note that a measurement without a calibration is not possible!
= You must assign a new calibration to the batch!

= Using this function you also delete the locked calibrations in the probe/DMP-
F probe adapter!
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Before you start

= The probe is connected to the gauge containing the memory from which you
want to delete all calibrations.

To delete all calibrations from the memory of the connected probe
1. Call up the delete function: [= > Gauge Settings > OK > Probe - Menu > OK > Delete
all calibrations > OK.
2. Start the delete process: v,
3. Exit the menu: ¥\, the delete process has finished.

The delete process has finished, the calibration memory of the probe is now empty.

What you should do next

m Create new calibration(s), see page 56
= Assign the new calibration to the batch, page 37
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The gauge provides you with the mathematical calculations, complex and extensive
at times, needed for statistical evaluation of the measured readings from the batch.
The evaluation refreshes continuously in the background during the measurement.

The statistical characteristic variables of the batch are displayed in the Statistics
menu.

10.1 Batch statistics

= Display statistical characteristic variables for all NFE/FE ® =
measured readings of the batch: =l > Statistics > Batch Statistics
OK.

m  Display histogram for all measured readings of the
batch (possible from 5 measured readings): =] >
Statistics > OK > eee > Batch Charts > OK > Histo-
gram > OK.

9

If no measurement data appear for the class divi-
sion, the display refers to the entire measurement
range of the connected probe.

I,
=)

Description of the characteristic variables, see Example of batch statistics
page 14
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11 Data transfer

Data export is possible only from the gauge to the Tactile Suite software program.
Individual measured readings, batch statistics and the entire batch can be exported
to Tactile Suite.

Tactile Suite is a software solution for evaluating measured readings, creating in-
spection reports, archiving measured readings, inspection reports and batch files,
and for exporting measured readings in CSV format.

You can download the Tactile Suite program free of charge from the Fischer down-
load page.

Information on how to use the Tactile Suite software program can be found in the
corresponding Operator's Manual (B3 Tactile Suite).

Fischer download page:_https://docs.helmut-fischer.com/uum

Notes on data transfer

= Calibration data cannot be transferred.

® Interfaces: USB

® You can write the measured readings directly into an Excel spreadsheet
online via Tactile Suite during the measurement.
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11.1 Data transfer via USB

Before you start

= The Tactile Suite software program is installed on the PC and opened.
= The gauge is switched off.
= The USB cable from the scope of supply is ready.

For the data transfer, use the USB cable from the scope of supply or any other

commercially available USB cable with a C/A-type plug; maximum usable cable
length: 3 m (118.1 ")

To transfer data to Tactile Suite via USB

1. Connect the gauge to your PC.
Use the USB connection on the top of the gauge.

1. 2.

2. Switch on the gauge: (O]

The gauge is automatically detected and displayed in Tactile Suite in the menu on the
left. All data from the gauge are synchronized with Tactile Suite.
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12 Batch settings

For the batch, you can make settings that do not directly affect the measurement,
such as changing the Measurement view, the max. number of decimal places for the
displayed values or calling up the batch information.

12.1 Calling up information about the batch

You can call up information about the batch. All settings, assigned calibration and
probe information with which this batch works with are listed on an information

page.

To call up information about the batch

1. = > Batch Modify > OK > Batch Info > OK
2. Exit the information page: ¥\

Description of parameters on page Batch Info
Batch Name
Name of the batch file.

Probe Name
Name of the probe with which this batch works.

Probe Serial Number
Serial number of the probe with which this batch works.

Calibration
Name of the calibration assigned to this batch.

Limits [um]
Information on specification limit monitoring: off or indication of the specification
limits (LSL and USL)/ the specification limit (LSL).

Measurement View
Type of Measurement view set for this batch (Simple, Statistics).
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Meas. unit
um (example)

Offset
Information about the offset: off or set offset value.

Measure Mode
Information about the set measuring mode: Single Readings or Free Running

Values rounding
Information about the resolution of the displayed values: number of decimal places
used to display the measured reading and the statistical values.

Save Readings

Information indicating whether this function is activated or deactivated for the batch.
Air Reference

Information indicating how the probe acquires the air value for the batch.

12.2 Changing the unit of measurement for the batch

You can change the unit of measurement for the batch, as well as its batch statistics.

To change the unit of measurement

1. = > Batch Modify > OK > Meas. unit > OK > select desired unit of measurement
> 0K
Unit of measurement is activated: @

2. Have you selected the Own Unit unit of measurement?
® No: Continue with step 3.
® VYes: Set the desired variables for your own unit of measurement:

a & : Select the parameter Own Multiplier and set the multiplier related to
the unit of measurement um.

b & : Select the parameter Own Unit and assign a name for the unit of
measurement.

Change the name:

® Move cursor using the ¥\ and OK keys

® Select characters using the @ and OK keys
® Delete characters by selecting the space (i)
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Exit the dialog page Rename:

a Use the OK key to move the cursor to the far right until the character
@] appears at the right edge of the display.

b Exit the dialog page: OK.

3. Exit the menu: ¥\, the settings are now made.

The previous measured readings and statistical evaluations are converted and dis-
played according to the newly set unit of measurement.

12.3 Selecting the Measurement view for the batch

You can display various items of additional information for the batch. You can choose
between two Measurement views.

The display screens below should be considered only as examples; batch 001 has set specifica-
tion limits.

Measurement view Measurement view
Simple Statistics (default mode)

Only the current measured In addition to the current

reading is displayed. measured reading, a mea-
sured reading statistic is
shown in a table.

To select a Measurement view

1. = > Batch Modify > OK > Views Settings > OK > Measurement View > OK > select
desired Measurement view > OK
Measurement view is activated: ®
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2. Have you selected the Statistics Measurement view?
® Yes: Select the desired characteristic variables:

a % >0K
Characteristic variable is switched on: @®
A maximum of 6 characteristic variables can be displayed in the
Measurement view Statistics, description of characteristic variables,
&l 14.

b Continue with step 3.
® No: Continue with step 3.
3. Exit the menu: ¥\, the settings are now made.

The measured readings (and statistical evaluations) are displayed according to the
newly set Measurement view.

12.4 Selecting characteristic variables for the statistical display

For the batch, you can select the statistical characteristic variables that are to be dis-
played on the evaluation page Batch Statistics.

To select the statistical characteristic variables

1. = > Batch Modify > OK > Views Settings > OK > Batch Statistics View > OK
2. Select the desired characteristic variables: : > OK.

Characteristic variable is activated: @®

Description of the characteristic variables, B 14

3. Exit the menu: ¥\, the settings are now made.

12.5 Setting the decimal places for the display values
For the batch, you can set the number of decimal places for displaying the measured

reading and for the values of the statistical characteristic variables both in the Mea-
surement view and in the statistical display.
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To set the decimal places for the display values

1. = > Batch Modify > OK > More Settings > OK > Values rounding > OK > select
desired max. number of decimal places > OK
Parameter is selected: @

Parameter selection:

® [ ow: maximum 1 decimal place is displayed
0.9/9.9799/999 /9999

® Medium: maximum 2 decimal places are displayed
0.99/99/99.9/999 /9999

® High: maximum 3 decimal places are displayed
0.999 7/ 9.99/99.99 /1 999.9 / 9999

2. Exit the menu: ¥\, the settings are now made.
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13  Gauge settings

The display language, date, and time, for example, are general gauge settings and
also apply to the batch.

In addition to the general gauge settings, you can also retrieve information about the
gauge software, copyright, etc. from the Gauge Settings menu.

13.1 Setting the language

You can set the display language for the gauge.

To select the language

1. = > Gauge Settings > OK > Language > OK > select desired language > OK
Parameter is activated: @

2. Exit the menu: ¥\, the language has now been set.

13.2 Display settings

You can activate and deactivate the automatic flip display view according to the
gauge position, and also adjust the display brightness.

To change the display settings

1. = > Gauge Settings > OK > Display Settings > OK
® Activate/deactivate flip function for the display: Flip Display > OK.
Parameter is activated: @®
® Set display brightness: Brightness > OK > set desired brightness value > OK

2. Exit the menu: ¥\, the settings are now made.
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13.3 Signal settings — visual and audible signals

You can activate and deactivate the sound and light signals for measured reading ac-
quisition and specification limit violations.

To activate/deactivate the signals

1. = > Gauge Settings > OK > Signal Settings > OK
2. Select the desired signal function: & > OK.
Function is activated: @®
® Parameter Light intensity, set the desired brightness value: § > OK
The higher the set value, the higher the luminosity.
3. Repeat step 2. for more menu functions.

4. Exit the menu: ¥\, the settings are now made.

Signals

Beeps/ Visual signal Meaning

beep probe + gauge

1 x short 1 x green Measured reading acquisition, measured
reading is within the specification limits/
above the specification limit when specifi-
cation limit monitoring is activated

1 xshort+ 1 xlong|?2 x red Measured reading is outside the specifica-
tion limits/below the specification limit
when specification limit monitoring is acti-
vated

13.4 Energy saving

To prolong the battery life as far as possible, the gauge offers automatic shutdown
and display dimming as energy-saving functions.
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To change the shutdown and dimming times, and also the dimming
strength

1.
2.
3.

[= > Gauge Settings > OK > Energy Savings > OK
Select the desired function: $ > OK.
Set the desired time value/dimming strength: & > OK

Shutdown time 0 min: Function deactivated, there is no automatic gauge
switch-off or display dimming

max. shutdown time: 1000 min.

Repeat steps 2. and 3. for more menu settings.

5. Exit the menu: ¥\, the settings are now made.

Description of the energy-saving functions

13.5

Switch off after

Automatic gauge shutdown after a preset period of time without any action (key
confirmation or measured reading acquisition)

Switch off (USB)

Automatic gauge shutdown after a preset period of time without any data
transfer via USB interface

Dim display after

The display brightness is automatically dimmed to the specified brightness val-
ue (Dimming Ratio) after a preset period of time.

Date & time

You can set the date and time as well as the date and time format for the gauge.

To set the date & time

1.
2.

(= > Gauge Settings > OK > Date & Time > OK

Select the desired parameter: & > OK.
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3. Set the desired time or date or select the desired format:
Date and time setting
® Move cursor using the OK and ¥\ keys
® Number selection using the @ keys
Format selection: & > OK
Format is selected: @
4. Repeat steps 2. and 3. for more menu settings.

5. Exit the menu: ¥\, the settings are now made.

13.6 Default settings for unit of measurement and decimal places

The menu functions Preset Unit and Preset rounding under [= > Gauge Settings > OK
> More Settings > are inactive.

13.7  Activating/deactivating lock code

Use the lock code to activate/deactivate the lock function (Lock Calibration) for select-
ed calibrations.

To activate the lock code

1. = > Gauge Settings > OK > More Settings > Define Lock Code > OK > set desired
lock code > OK

2. Confirm the activation information: OK

3. Exit the menu: ¥\, the lock code has now been activated.

To deactivate the lock code
You must know the lock code to deactivate it.

1. = > Gauge Settings > OK > More Settings > Delete Lock Code > OK > set lock code
> 0K

2. Confirm the deactivation information: OK

3. Exit the menu: ¥\, the lock code has now been deactivated.
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13.8 Reducing electromagnetic interference on the measurement

When the magnetic induction test method is used, the electromagnetic interference
radiation from the local mains voltage can influence the coating thickness measure-
ment. Such interference radiation can occur close to transformers, for example.
When the local mains frequency is selected, the gauge compensates for this inter-
ference.

Not relevant for the ISOSCOPE® gauge models

To set the frequency of the local voltage supply

1. = > Gauge Settings > OK > Probe - Menu > OK > Set Power Line Frequency > OK
> select local mains frequency > OK
Parameter is selected: @

2. Exit the menu: ¥\, the settings are now made.
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14.1 Probe — count rate recording/display

For error analysis, it can be helpful to view the count rates delivered directly from
the probe. Our experts can use the count rates shown in the display to draw conclu-
sions about the status of the probe, for example, and propose potential solutions.

The count rates are measured and displayed in a service area, and this does not af-
fect the batch.

You can also export the count rates, although only during the measurement (online),
to an Excel® table via USB and Tactile Suite.

Before you start

= The probe with count rates to be checked is connected to the gauge.

= Foradatatransfer to Excel® the software programs Tactile Suite and MS Excel
are installed on the PC and opened. The USB cable from the scope of supply is
ready.

For the data transfer, use the USB cable from the scope of supply or any other

commercially available USB cable with a C/A-type plug; maximum usable cable

length: 3 m (118.1")

&1 The link for downloading Tactile Suite and additional information can be
found on page 67.

To display/export the count rates

1. [= > Gauge Settings > OK > Probe - Menu > OK > Probe Raw Values > OK > Coun-
trate - Check > OK

2. Carry out one of the following measuring methods:
® |ndividual measurements

® (Continuous count rate recording:
Place the gauge on the surface and press RUN; the gauge displays the
continuously recorded count rates.
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Finish continuous count rate recording: STOP

TH
Switches to coating thickness display in the count rate Measurement view
(unit of measurement set as in the batch)

XN
Switches to count rate display in the count rate Measurement display

3. Exit the menu: ¥\, the settings are now made.

14.2 Gauge cleaning

Switch off the gauge before cleaning it!

Cleaning the gauge

> Simply wipe away normal soiling, such as dust, with a damp cloth.

P> Wipe away oily deposits with a dry cloth and then clean the spots with plastic
cleaner or household detergent.

> Remove paint and lacquer using a solvent. Use solvents such as acetone,
methyl ethyl ketone, turpentine oil, or xylene to clean the gauge.

o ATTENTION - Damage to the gauge/probe

= Do not clean the gauge/probe under running water!

m |[P64 # water-proof, gauges in protection class IP64 are resistant only to
splash water. They are not waterproof and cannot withstand constant water
pressure!

m Scratches on the display
Cleaning the display with a dry cloth can scratch the display.
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15 Gauge information

All gauge information, such as information about its status, firmware and legal infor-
mation can be found in the Gauge Settings menu.

To call up the information page

1. = > Gauge Settings > OK > About > OK
— Scroll, display next page

2. Exit the information page: ¥\
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